
            

 

 

                                                                                                  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The MKPA exists to support the co-operation of camera clubs within the greater Milton Keynes area. 
 
Each club receives newsletters once a year to define rules and provide entry forms for the next round of 
competitions. There is an individual projected image competition for digital images. There is also an 
individual print competition subdivided into Monochrome and Colour. The individual Audio-Visual competition 
is for “Creative Digital”. 
 
Membership of the organisation is £10.00 per club per year plus 10p per member. 
The MKPA is not directly part of the CACC, or the PAGB. Your club must join one of the federations if you 
need the benefits they provide. 

 

 
 

 

 

 

MMMMMMMMKKKKKKKKPPPPPPPPAAAAAAAA        NNNNNNNNeeeeeeeewwwwwwwwssssssss        22222222000000000000000088888888////////99999999        
SSeepptteemmbbeerr  22000088              TThhee  MMiillttoonn  KKeeyynneess  PPhhoottooggrraapphhiicc  AAlllliiaannccee  ––  ssuuppppoorrttiinngg  tthhee  ccoo--ooppeerraattiioonn  ooff  ccaammeerraa  cclluubbss  iinn  tthhee  ggrreeaatteerr  MMiillttoonn  KKeeyynneess  aarreeaa..  

Club Information 

 
FOCUSFOCUSFOCUSFOCUS    
Contact: Contact: Contact: Contact: Patrick Doggett ARPS 01908 662115    
    
LEIGHTON BUZZARD PHOTOGRAPHIC CLUBLEIGHTON BUZZARD PHOTOGRAPHIC CLUBLEIGHTON BUZZARD PHOTOGRAPHIC CLUBLEIGHTON BUZZARD PHOTOGRAPHIC CLUB    
LBPC meets on Wednesdays at 7.30 for 8.00 pm at 
Greenleas Lower School, Derwent Road, Linslade. 
Contact: Contact: Contact: Contact: Paul Searle LRPS – 01525 372075 
www.lbpc.me.uk 
 
NEW CITY PHOTOGRAPHIC SOCIETYNEW CITY PHOTOGRAPHIC SOCIETYNEW CITY PHOTOGRAPHIC SOCIETYNEW CITY PHOTOGRAPHIC SOCIETY    
NCPS meets on Thursdays at 7.30pm for 7.45 pm start in the 
Tickford Centre, adjacent to Middleton Swimming Pool, off 
Tickford Street, Newport Pagnell. 
Contact:Contact:Contact:Contact: Jeff Watt – 01908 610976 
www. newcityps.co.uk    
 
OLNEY CAMERA AND PHOTOGRAPHY CLUBOLNEY CAMERA AND PHOTOGRAPHY CLUBOLNEY CAMERA AND PHOTOGRAPHY CLUBOLNEY CAMERA AND PHOTOGRAPHY CLUB    
OCPC meets on the last Wednesday of each month 8-10pm 
at The Olney Centre, High Street, Olney. 
CCCContact:ontact:ontact:ontact: Colin Gadsby 
www.olneycameraclub.co.uk 
 

 

MKPA Committee 
 

Chairman  Graham Allsop  01908 610751 
Secretary  Paul Searle LRPS   01525 372075 
Hon Treasurer  Ruth Meardon 01908 522715 

Newsletter Editor  David Gillow   01908 501788 
 

 

Patrick Doggett ARPS (focus) 01908 662115 
Jeff Watt (NCPS) 01908 610976 

Geoff Stone (OCPC) 01234 720786 
 

Other Useful Contacts    
 

CACC [The Chilterns Association of Camera Clubs] 
Chairman Stan McCartin 01296 620685 

 
 
 

RPS [The Royal Photographic Society] 

Reg. Organiser Dr M D Buckley-Sharp ARPS 0208 907 5874 

 

THIS SEASONS COMPETITIONS 

DIGITAL IMAGES   New City Photographic Society   16th October 2008  

AV:    Focus       26th January 2009 

PRINTS:   Leighton Buzzard Photographic Club  25th February 2009 

 

LAST SEASONS WINNERS 

PROJECTED IMAGES Doug Child    NCPS 

AUDIO VISUAL  Dave & Carol Gillow  LBPC 

PRINTS MONOCHROME Carol Gillow LBPC  COLOUR Carol Gillow LBPC 



 

 

 

Each year, individual members of MKPA affiliated clubs are invited to find the best photographer in The Alliance by 

competing for the MKPA trophies.  In addition, certificates will be awarded to the runners-up. 

These are not inter-club competitions.  All entries will be judged.  The rules are below.  Entries not conforming to these 

rules will not be accepted. Please make sure that your entry, together with the fee, is delivered to your club competition 

secretary who will forward the combined entries to the appropriate co-ordinator. Also please ensure that trophies are 

returned by the same due date as the entries to give co-ordinators time to get them engraved. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

MKPA TROPHY PROJECTED IMAGES COMPETITION – Thursday 16th October 2008  - Hosted 
by New City Photographic Society at the Tickford Centre, Newport Pagnell.  Judge  Keith Long ARPS from Duston 
CC  
 

PROJECTED IMAGES COMPETITION RULES 
1. The subject matter in this section is open. 

2. A total of TWO entries per author will be allowed. 

3. Entries and trophies are to be with Jeff Watt together with the entry fee of  £1 per image on or before 25
th
 

September 2008 . 
 

DIGITAL IMAGES 
1. All images should be no more than 1024 pixels wide by 768 pixels high. If the dimensions of your image are less 

than this please surround it with a pure black background otherwise the projection process may distort your image.* 

2. Files must be supplied on CD in JPEG format and pre-checked for viruses. CDs not collected on the competition 

night will be destroyed. CDs should be marked with the Author’s name and Club 

3. Files must be named in the following format   SLEEPING TIGER by John Smith.jpg   to enable use of automatic 

listing and scoring software 
 

* How to resize your image to 1024 x 768 pixels JPEG using AdobePhotoshop 
 

All digital images will be judged at a resolution of 1024 x 768 pixels. The 1024 is the width across, making the image a 

landscape format. You should resize your image to fit within that pixel area. Any space around your image should be filled 

with a black background. This is how you do it using Photoshop. 

 

1. From the Image menu choose Image Size. 

2. Tick the Constrain Proportions and Resample Image boxes. 

3. In the Pixel Dimensions area select pixels in the units boxes. 

4. Enter the width you want, for example 1024. The height will adjust automatically. 
 Check the height. If the height is more than 768, then you need to enter 768 in the height – this will reduce the 

width to less than 1024 pixels. Click Ok. 

5. Adding a background. If your image is not exactly 1024 x 768 then we will judge it with a black background filling 
the remaining space. To fill in the background proceed as follows. 

6. Set the background colour to black. 

7. From the Image menu, choose Canvas Size. 

THIS SEASON’S COMPETITIONS 

GENERAL RULES – These rules apply without exception to all competitions 
1. Copyright for all pictures must reside with the photographer.  

2. Soundtrack copyright must be covered by an appropriate licence. 

3. Previous entries are not eligible. 

4. In the event of a dispute, the decision of the chairman of the MKPA will be final. 

5. Every entry is to be marked with the entrant's name, club and section for which it is entered. 

6. Titling of the digital images would be appreciated but is not compulsory. 

7. Organising Clubs to provide results of the winning presentation to the Secretary. 

8. All facilities for projection or display of entries to be provided by the host club. 
9. Entries in the Competition shall be open to one or more fully paid-up members of any club that 

is a member of the Milton Keynes Photographic Alliance. 

 
Entry fees are designed to cover Competition expenses. Any shortfall will be made up from MKPA 

funds.  Any excess will be paid into MKPA funds. 



8. Make sure the units are set to pixels. Type in 1024 for the width and 768 for the height. 

9. Click OK. Your image canvas is now enlarged to show the picture and the spare margins around the outside filled 

with black. 

10. To save the image as a JPEG file, from the File menu, choose Save As. 

11. Select the folder you want to save to. 

12. Type in the image title in the format SLEEPING TIGER by John Smith.jpg   

13. In the Format field set JPEG. 
14. Click the Save button. In the JPEG Options box set compression to 10 or 11. Make sure the Format Options is set to 

Baseline (“Standard”). Click Ok. Then write to CD in the normal way 

 

 

 

 

 

 

 

MKPA TROPHY PRINTS COMPETITION – Wednesday 25th February 2009 – Hosted by Leighton 
Buzzard Photographic Club at Greenleas Lower School, Derwent Road, Linslade.  Judge  Stan McCartin  LRPS 

CPAGB 

 

PRINT COMPETITION RULES 
1. The subject matter in each section is open.  The two sections are: 

a.    Monochrome prints. 

b. Colour prints 

2. Entry is limited to TWO prints per section per entrant.  

3. Prints must be mounted and may be up to 50 mm x 40 mm. All prints submitted should be suitably protected.  

4. There should be no author’s name on the front of the print and no “Velcro” or similar fixings on the back as this 

may damage adjacent pictures 

5. Please do not submit the same image in more than one section. 

6. Entries will automatically be considered for hanging in the MKPA prints Exhibition if this can be arranged by the 
host club. 

7. Entries and trophies are to be with Paul Searle together with the entry fee of £1 per print by Wednesday 4th 

February 2009. 

 

MKPA AUDIO-VISUAL COMPETITION – Wednesday 28th  January 2009 - Hosted by Focus at 
Greenleas Lower School, Derwent Road, Linslade (by invitation from LBPC). Judge Colin Harrison FRPS MPAGB 

BPE5* of Oxford CC 

 

AUDIO-VISUAL COMPETITION RULES 
1. There will be one Section in the Audio-Visual Competition.  – “Digital, Anything Goes, Creative” 

2. Each club may submit up to four entries, all by different authors. 
3. The images need to last not less than two minutes and no longer than five minutes and be accompanied by a 

soundtrack. 

4. All A/Vs to be supplied on a standard CD as an executable file or in a form to be run on a standard Windows PC. 
5. A draw will be held to determine the order of entry. 

6. The Judge will be asked to choose first, second and third entries, together with any entries he wishes to commend, 

provided the total number of awards does not exceed 25% of the total entries.  The Judge will have discretion to 

withold any or all of the awards. 

7. In the event of a technical breakdown during a presentation, a reasonable opportunity (at the discretion of the host 

club and judge) will be given for the entry to be re-presented. 

8. Any changes to these Rules must be agreed by the MKPA Committee. 

9. The majority of the A/V content must be the original work of the author. 

10. Entries and trophies (plus fee of £4 per A/V) to be with Paul Searle by 12th January 2009  

                                                                                                                                                                                     

 

Digital Projector InformationDigital Projector InformationDigital Projector InformationDigital Projector Information    
Digital projectors are still in their formative years and are not yet designed for photographic quality projection. Although continuing to 
improve they often have a noticeable colour cast, which varies from machine to machine. They do not have a very great tonal or 
contrast range compared to film, or even CRT monitors, and are usually best at showing mid-range tones. Highlights tend to burn out 
and shadows block up easily. Accordingly avoiding images with large areas of a gentle tonal range, particularly light colours, may be 
a good idea. 



 
 

For entry rules please refer to MKPA News 2008/9 
 

 

THIS SEASON’S ENTRY FORMS 

Audio-Visual – Entries & Trophies to be with Paul Searle by 12th January 2009 

 
……………………….  Club would like to enter the following Audio-Visual presentations. 

All authors are paid up members of this club. We enclose £4 per entry and a CD containing executable files. 

Signature of club official ……………………………………………… 

 

 Author Sequence Title Length 

Minutes 

1    

2    

3    

4    

 

Prints – Entries and Trophies to be with Paul Searle by Wednesday 4
th
 February 2009. 

 
Name ………………………….. I certify that I am a fully paid up member of ………………………… Club 

I enclose the following prints and fee of £1 per print: 

 

Section A 

Monochrome 

Title Section 

B 

Colour 

 

1  1  

2  2  

 

Projected Images – Entries & Trophies to be with Jeff Watt by 25
th
 September 2008 . 

 
Name ………………………….. I certify that I am a fully paid up member of ………………………… Club 

I enclose the following digital images and fee of £1 per image: 

 

 Title 

1  

2  

 
 


